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This book is one of the additional reference sources that
focus on Project Management for all students who take
Computer Application Subject or who are interested in

this topic. 
 

The book s originality is evident in the easy-to-
understand content, which is presented in a compact
format to make it easier for students and readers to
make references. The book is illustrated with photos

that are linked to the issue being addressed, in order for
the students to be able to relate to the real-life

situation. 
 
 

Preface

ii



Contents

1  PROJECT OPTIONS
SETTING 

Introduction                                                 2      
Setting Your Project                                    3
Currency Formatting                                   4
Options Schedule Setting                           5
Advanced Setting                                       6
Practice 1                                                     7

2 SCHEDULING
TECHNIQUES

Scheduling Techniques Overview                9
Task Relationship                                        10
Constraints to Control Task Scheduling     14       
Calendar Set up                                         16
Change Working Time                                 18
Create a recurring task                             20
Practice 2                                                 23

Acknowledgement                                      i
Preface                                                      ii       

iii



3  VIEW AND
REPORTING

Reporting Overview                                   25 
Project Status: View and Report               26
View Project Statistics                              27
View Report on Dashboard                       28
Display Cost table in the Task 
Sheet View                                                32
Display Task Cost Overview or Cash Flow
Report                                                        32
Display Cost table in the Resource
Sheet View                                                33
Practice 3                                                  34

Contents

4  FORMAT AND PRINT

 
 
 
 
 
 
 

Format and Print Overview                        36
Organize Global Template                        37
Format a Gantt Chart View                      38
Timeline View Formatting                          39
Create Custom Report                              40
Add Chart to a Report                               41
Change a Chart s Format and Style         42
Add a Table to a Report                            42
Print a View or Report                               43
Check Out the Print Layout                       44
Practice 4                                                  45

Keyboard Shortcuts                                            46          

References                                                               47          

iv



Stamp

Rectangle

FreeText
CHAPTER 1

FreeText
PROJECT OPTIONS SETTING



2

Application Options –

Project-Specific Options –

Options for All New Projects

There are many project s basic options and settings that can be customised
in MS Project so that every schedule is set up the same way. 

In this topic, we will learn how to set options to make it easier to start
scheduling a project. These basic options are fundamental to starting a
schedule on the right foot.

Changes to these settings can be made from the File tab, often known as
the Backstage, or through the Microsoft Project user interface on the
ribbon.

Microsoft Project offers three (3) types of options in the Project Options
dialog.

These option types include:

These options control how the software looks and works, and they impact
every project you open. You only need to set these options once, as they are
not project-specific.

You can set these options to any project currently open. Because these
options are project-specific, you can specify different options for each
project, depending on the type of project.

These options impact all new projects created from the Blank Project If you
regularly create new projects from a blank project, you definitely need to
set these options so that you do not need to set them manually for every
new project you create.
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Click Info, go to Project
Information and click,

Choose Advanced
Properties, Properties

popup appear, click
Summary Tab and give the
title for your project. The

title will appear on
Summary Task (ID: 0)

 

Setting Your Project

Enter Plan Title and Other Properties

The MS Project, like other Microsoft Office programs, maintains track of a variety of
document attributes. Statistics, such as the number of times the document has been
updated, are among these features. Other characteristics include information about
a plan that you would want to keep track of, e.g., the name of the project manager,
the project title, or search terms to aid in finding it.  Majority of these characteristics
are used in Page Headers, Page Footers, Reports, and Views when printing.  The
Properties dialogue box allows you to review and make a note of these properties.
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Click on Option, go to Display on Project Option and change the
Currency Formatting

Currency Formatting

Default currency is USD, you need to change it based on country used, as
Malaysia we change to MYR



Options Schedule Setting

The Project Schedule Setting Options.

5

 1. Run Microsoft Project                  open a blank project.

2. Click on File tab               select the Options menu item..

3. The project options dialog appears as figure in above

4. Select the Schedule item.

5. Choose the All-New Projects option from the picklist after finding the 
     scheduling options for this project area.

6. On  New tasks created                Auto Scheduled.

i.  Set Auto scheduled tasks scheduled on                Project Start Date.

ii.  Duration is entered in                Days.

iii. Work is entered in               Hours.

iv. Default task type                Fixed Duration.

v. New tasks are effort-driven                 uncheck.

vi. Auto link inserted or moved tasks                uncheck.

vii. Keep task on the nearest working day when changing to  
      Automatically Scheduled mode                 uncheck.

viii. All other checkboxes in the scheduling options section               check

ix. Click OK button.
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i.   Go  to File tab                Options menu item.

A common mistake people make in Microsoft Project is to create a task
with the project name at the very top of their project plan.

Microsoft Project will do this for you automatically by displaying the
project summary task.

Since the project summary task is not a default option, you need to enable it.
Follow these steps to display the project summary task at the top of your
project:

 The show project summary task dialog box

Advanced Setting

ii. The project options dialog appears as shown above

iii. Click the Advanced item.

iv. Locate the section titled "Display choices for this project" and choose 
      "All New Projects" from the drop-down menu..

v. Tick checkbox of the Show project summary task.

vi. Click OK button

choose 
 "All New Projects" from

the drop-down menu
 



7

Practice 1
You want to establish a new company and need to
develop a business plan. Before you begin working on
your MS project, make sure you have the following
configuration and options:

 A new task on the status bar show: Auto scheduled
 Currency in Ringgit Malaysia
 Start working day on Monday
 Auto Project Summary task Appear
 Setting an Author and Manager of the project

1.
2.
3.
4.
5.
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A schedule is made up of all the activities involved in planning,
implementing, and completing a project within the time frame
specified. A project schedule assists in prioritizing and organizing the
work required to complete a project. Furthermore, it aids in the
selection of the best candidate for the position as well as the
efficient distribution of available resources.

A schedule is a list of all the tasks that must be completed within the
time frame specified during the project s planning and execution. A
project timetable aids in task prioritization and project completion.
Furthermore, it aids in making the best hiring decisions and making
the best use of available resources.

Scheduling Techniques Overview
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This chapter describes how to control task scheduling with constraints, view
task relationships with Task Path, changing task link relationships, delay a
preceding task, adjust the working hours for specific tasks, use Task Kinds to
control task scheduling, and use Task Inspector to view task schedule
specifics.

All tasks in this Gantt chart view, regardless of their ties to predecessor and
successor jobs, have the same bar and link colours.

Enable Task Path Predecessor Formatting to view the preceding tasks in a task
sequence.

Task Path formatting highlights the Gantt bars of task 7 s predecessor tasks in
gold.

There may be a large list of tasks that came before it, but which of them is in
charge of scheduling the current task? Task Path can be used to visually
discern these driving ancestors.

Task Path format gives the Gantt bars of task 7 s preceding driving tasks a
dark orange glow.

10

Task Relationships



Using the Task Path style, format a task s
predecessor or successor tasks.

1. In a Gantt chart                  task name column.
2. On the Format tab           Bar Styles group    
    Task Path button              Select the choices
     you need.

Remove Task Path formatting

1. Select Format tab           Bar Styles group        
    Task Path button           click Remove 
     Highlighting.

Modify the relationships of task link 

There are four (4) different kinds of task dependencies or
relationships:

Finish-to-start (FS) 

Start-to-start (SS) 

Finish-to-finish (FF) 

 Start-to-Finish (SF)  

       The predecessor task s completion date determines when the successor  
       work will begin.

       The start date of the successor task is determined by the start date of 
       the predecessor task.

       The successor task s completion date is set by the conclusion of  
        the predecessor task.

     The predecessor task s  start date affects the successor task s
     completion    date.

Activities in Project are automatically given a finish-to-start relationship when
they are linked  using the Link Tasks button on the Task tab in the Schedule group.
This is acceptable for a lot of activities, but as you polish your plan, you will
undoubtedly need to change certain task linkages. The jobs that require
relationships other than finish-to-start relationships include some of the
following.

11



As soon as you begin working on an illustration assignment for a book, you can
begin setting pages (a start-to-start (SS) relationship). The total time required
to complete both tasks is decreased because the two tasks are performed
simultaneously.

In a a start-to-start relationship (SS), the predecessor task s start date sets
the start date of the successor task. 

Add lag time to the relationship to create a pause between the predecessor s
end and the start of the successor.

The default task relationship for a project is finish-to-start (FS)

The start of the succeeding work is delayed by
this lag time by 7 days and 2 hours.

The finish date of the predecessor task dictates the finish date of the
successor work in a finish-to-finish relationship (FF).

For example, it is feasible to begin preparing book editing before the
manuscript is ready. However, it cannot be done until the manuscript is
completed. You want both chores completed simultaneously time.( a finish-
to-finish relationship).

The successor task starts before the predecessor task is finished because of
lead time.
Due to lag time, the successor work begins after the predecessor task has
been completed.

When two tasks are linked from finish-to-start:

12
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To change  the sort of task relationship that exists between tasks

1. Choose a successor task that you want to modify..

2. Click  Information button in the Task tab. View the Task Information
dialogue box, which displays details of the selected task.

3. Select Predecessors from tab menu.

4.  On Predecessors tab, in the Type column, choose the form of relationship to
establish between the tasks. , then click OK.

5. Click OK.

 To add time between related tasks as a lead or lag

1. Select the successor task which you want to add lead or lag
time.

2. Select the Information button in the Properties group of the
Task tab.

3. Select the Predecessors tab in the Task Information
dialogue box, and then choose one of the following options:

For a predecessor task, specify the exact lead value in
the Lag field. Negative lag values represent lead
values. Lead can be stated in terms of working days
(for example, -2d) or as a percentage of the prior
tasks duration (for example, -25 percent ).

Put the appropriate lag value in the Lag area for a
preceding task. For lag values, positive numbers are
used. Lag can be stated as a number of working days
(for example, 3d) or as a percentage of the prior task s
time (for example, 50 percent ).



Task Scheduling Constraints 

Every task you enter into Project comes with a constraint. A limitation governs how
far an automatically scheduled task can be postponed. The constraint details of
automatically scheduled jobs can be managed.

However, you cannot change the constraint type or specify a constraint date when
working with a manually scheduled task .

Constraints are divided into three categories:

Flexible constraint

Semi-flexible constraints

With this restriction, a task has a start or end date boundary. Within
that limit, however, Project has the scheduling flexibility to change a
task s start and finish dates.

Inflexible constraint 

A constraint that requires a task to start or end on a specific date. MSO
(Must Start On) and MFO (Must Finish On) are both rigid limitations.

Click the constraint indicator in the Indicators column to reveal the constraint
type and date.

14



Using a task constraint

1. Select the task to which you want to apply the constraint.

2. Click the Information button in the Task tab s Properties group.

The Task Information
dialogue box can be
opened by double-

clicking a task name.

TIPSTIPSTIPS

3. Select the Advanced tab in the Task Information 
     dialogue box.

5. Enter or choose the preferred date in the
Constraint Date box, then click OK.

All constraint types, with the exception of As
Soon As Possible and As Late As Possible, demand
a constraint date.

4. In the Constraint Type box, select the constraint
type you want.

To remove a task constraint

1. Choose a task to which a constraint has been applied.

2. In the Properties group of the Task tab, select the Information button.

3. Select the Advanced tab in the Task Information dialogue box.

4. Select As Soon As Possible or As Late As Possible in the Constraint 
     Type box (if scheduling from the project finish date).

15



Adjust working time for individual tasks

You re working on a task that needs to run overnight, and you re using the
Standard base calendar as your project calendar. Your typical working hours are
8:00 a.m. to 5:00 p.m.
You have a task that needs to be completed on a certain weekday.
You have a task that needs to be completed over the weekend.

Here are some scenarios in which a task calendar may be useful:

On Project tab, Click the Change Working Time button in the Properties group to
access the Change Working Time dialogue box.
Click Create New Calendar in the Change Working Time dialogue box to launch
the Create New Base Calendar dialogue box.

Create a new base calendar.

1.

2.

Give a new base calendar a name that makes
sense to everyone who will be using it.

Click Create New Base Calendar to make a new calendar with working hours of 8:00
a.m.–5:00 p.m. Monday–Friday.
To make a new calendar that is based on an existing base calendar, select Make a
copy of from the drop-down menu and choose the base calendar you want from
the list (24 hours, Night Shift, Standard).

3. Type the name of the new base calendar in the Name Box, and then select
one of the following :

4. Select OK.
5. Enter the particular working time exceptions or overall modifications you
desire for this calendar on the Exceptions and Work Weeks tabs of the Change
Working Time dialogue box.
6. To close , click OK.

You can change Calendar 1 to New Name

SET UPSET UPSET UP      A CALENDARA CALENDARA CALENDAR

16



 Select the task to which the base calendar will be applied.
Click the Information button in the Task tab s to launch the Task
Information dialogue box.
Select the Advanced option from the drop-down menu.
Select the base calendar from the list of available in the Calendar box.

To use a base calendar to complete a task
1.
2.

3.
4.

Apply a base calendar to a task using Calendar field in
the Task Information dialogue box.

5. Close the dialogue box by clicking OK. 
The base calendar is applied to the task. In the  Indicators column, a  
 calendar icon appears, informing the task has a task calendar assigned to it.
6. Point at the calendar icon to see the calendar s details. The calendar
details are displayed in a ScreenTip.

The calendar show s on Screen Tip displayed 

17



Click Ok button when
finish.

After finish setting 

Click on Work Weeks tab 

Click Details button 

CHANGE WORKING TIMECHANGE WORKING TIMECHANGE WORKING TIME

Adjust the project calendar s working hours to fit your needs.

Change to a different base calendar (24 Hours or Night Shift, for example).

A project that you create schedules work using a base calendar that is set up by
default. This may be a standard Monday through Friday, 8 AM to 5 PM workweek, or
it could be something else that better fits the requirements of your organization.

If the working hours for your project are different from the standard hours, you
can:

OR

Change the working hours for your project.

If none of the base calendars available match the regular working schedule for
your project, you can change the project s working days and hours to make sure
that work is scheduled appropriately.

Is there a similar schedule being used by other projects? Create a new basic
calendar for your project s schedule to save your teammates time!

Let s start make a change

18



Click Set days to nonworking time
by choose the days which no work
can be scheduled. The change that
you make will be reflected in all the
months in the calendar.
Click OK

Click Set day(s) to these specific
working times for standard time
working and click OK. 
To set the working times for the
selected days, type the times that
you want work to start in the From
column and the times you want
work to end in the To column.

Click on Use Project default times
for these days.
Select the days that should use the
default working hours, which are
8:00 A.M. to 12:00 P.M. and 1:00
P.M. to 5:00 P.M., Monday through
Friday, and nonworking hours on
weekends, and click OK.

Let s Set working time for My Calendar

Then, 
Right-click the task, choose Information, select the Advanced tab, and then
select the calendar from the Calendar list.

19



Create a recurring task

In calendar program like Microsoft Outlook, recurring tasks in Project are similar to
recurring appointments. You can specify  its repeating pattern (for example, once
daily or once weekly) as well as the timeframe or number of repetition.

Click on Task tab go to Insert group Click on Task Click on Recurring Task

1. Type the name of the recurring task in the Task Name area.

To create a recurring task

Recurring Task Information dialogue box

2. Type the duration of each recurring task instance in the Duration field.

3. Specify how frequently the task should recur under Recurrence pattern.

6. Select OK.

4. Enter a start date in the Range of Recurrence box. You have the option of 
    specifying a specified number of occurrences or specific end date for the end date.

5. To use a specific base calendar for the  task, select it under Calendar for scheduling
     this task.  Select the Scheduling ignores resource  calendars check box if you want
     the specified calendar to override resource calendars.

20



Allocating resources to a recurring task

1. Pick the summary recurring task and then expand it.

2. In the Resource tab, click Assign Resources button.

3. In the Assign Resources dialogue box, choose the resources you want to attach
    with the recurring activity. To choose many resources, keep holding down the Ctrl
    key while selecting other names.

4. Select OK.

Assigning resources to a particular example of a recurring task

4. In the Assign Resources dialogue box, choose the resources you want to attach
    with the recurring activity. To choose many resources, keep holding down the Ctrl
    key while selecting other names.

1. To see the instances of the summary recurring task, expand it.

2. Choose the precise occurrence to which a resource should be assigned.

3. On the Resource tab. click the Assign Resources button 

5. Select OK.

Recurring setting for meeting during a project planning

On the screen tip
shows the recurring 

21
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Examine resource allocations over time

A resource s maximum units and resource calendar determine its capacity to
operate in a given time period. Allocation is the link between a resource s
capacity and its task allocations. A work resource could be any of the following
at any one time:

Underallocated: The resource s assignments do not use up all of the
resource s working capacity. 

Example: In a 40-hour workweek, a full-time resource with just 25
hours of work assigned is underutilized.

Fully allocated: The resource s assignments have used up all of the
resource s available capacity. 

Example: A full-time resource with 40 hours of work assigned in a 40-
hour workweek

Overallocated: The number of assignments assigned to the resource
exceeds the resource s maximum capacity to work. 

Example: A full-time resource who is allotted 65 hours of work during
a 40-hour workweek is overallocated.
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Practice 2
Once the configuration and settings are complete, create
the task and specify the start and end dates for each task
to establish a new company for the planning project. se
the following steps to create a project plan.

Task Relationship
 Set Resources
 Set the constraints
Create your own Calendar
Change working time
Set a recurring task for meeting

Create tasks for each cycle to detail the planning. Assign
resources for each task such as based on organizational
setting or equipment needed. From the task set the :

1.
2.
3.
4.
5.
6.
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 View and Report Overview
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The most crucial duty of a project manager is to communicate the project
status to key stakeholders. A project with poor communication is almost certain
to fail, even while good communication does not ensure project success.

The following questions must be addressed in order to successfully
communicate project status: Whom and why should be updated on the project s
progress? What kind of format or degree of detail are these people looking for?

Reports on the status of the project in terms of cost, scope, and schedule.
Progress reports that detail the project team s individual accomplishments.
Forecasts that indicate how well a project will perform in the future

The best time to address these questions is during the project s early planning
stages. Following the start of the project, your major communication role will
be to update the status of the project. This can take a variety of forms:

25



Project Status: View and Report 

Is the plan on schedule to conclude when we expect it to at the current rate of
completion?
What about the plan s length, scope, or cost changed?
How much has the plan s development cost thus far, and how much more is
anticipated going forward?

The project manager s attention switches from planning to obtaining, analyzing,
and disseminating performance information once work has begun and the
baseline for a plan has been established.

There are 3 (three) main things to ask when analyzing project performance
details in most plans:

Complete planning task
for Open House Event 

Display the project summary task on the
Format tab in the Show/Hide group to see the
overall project-wide numbers. In tabular
views like the Gantt Chart and using views,
you may also use a number of useful tables,
like the Cost and Variance tables. The task-
and resource-specific chapters that follow
this chapter go into further depth about these
tables.

Tips

By comparing the results to the baseline, the project manager and other
stakeholders may assess the situation and decide whether corrective action is
required.

When actual or scheduled performance deviates from the initial plan, a variance
arises. Variance is typically quantified in terms of time (days behind schedule) or
expense (dollars above budget). Following the completion of initial planning,
many project managers devote the majority of their time to finding, researching,
and responding to variance. You must first detect variance before you can
respond to it.

26



Get a quick "status-at-a-glance" overview of the situation by using the
Project Statistics dialogue box to start.

View Project Statistics

Click on Project tab            Project Information in Properties group      
 Statistics button

27



Click on Report tab        Click on New Report in View Reports group       

View Report on Dashboard

Make a new report.

Reports can be used to assess
data in your project and then
shared with your team.       

New Report

To improve your decision-
making, view eye-
catching, interactive
reports built on the facts
from your project.

Dashboards

"Project Overview"
"Cost Overview"
"Burndown reports"

Dashboard report that includes"

Click Report tab             on View Reports group             Dashboards               click on  the
Dashboard report you want.

You can choose the elements you want to include while constructing a new
report.

28



The Plan s total and remaining expenses, as well as previous and
anticipated cost trends, are displayed in the Cost Overview report.

The "Project Overview" report clearly displays the plan s overall
completion percentage of duration (in this case, 23%), a completion

percentage of each summary task, and other information.

Use the Project "dashboard" reports for reporting and analysis of wide
schedule and expense changes. We ll start by examining the Project Overview
report.

The overall progress of the summary tasks and milestones is the main
emphasis of this report. Sharing this report with project stakeholders who need
a high-level overview is a great idea.

When producing cost-focused reports, start with the "Cost Overview" report.
This report includes the total scheduled cost as well as the plan s current cost
status.

29



The Burndown report assists you in determining when the project will be
finished at the current rate of work.

The "Burndown" report is also another cost report that is essential for total
cost reporting.

This report outlines the amount of work completed, the amount still to be done,
and the anticipated pace of completion.

View Other Report 

Analyze reports based on
resource data to better manage
your team s work.

Resource Report

Display the  Overallocated Resources

When a resource is scheduled for more work than they can reasonably
complete given their regular work capability, this condition is known as
overallocation.

30



The Cost Distribution pie chart in the "Task Cost Overview" report totals task
costs according to their level of completion.

To see the cost of the plan and its accumulated cost values over time,
display the Cash Flow report.

By examining cost data in a
report, you can keep track of
your project s costs.

Cost Reports

31



Display the Cost table in the Task Sheet view

  1. On the View tab            click "Task Views" group            got to Other Views             
      to display the Task Sheet view            click  Task Sheet .
  2. On the View tab           Data group              Tables             Cost.

On the Report tab               View Reports group               Costs.
Select the report you want

Display the Cash Flow report / Task Cost Overview

1.
2.

32

Examine how your project
has progressed so far

In Progress

The "Late Tasks" report s primary focus is the current date, unless you specify a
different status date.

Use the "Late Tasks" report to concentrate on tasks that were finished
or will be finished later than expected.



On the View tab            "Resource Views" group           "Resource Usage" to
display the Resource Usage view.
On the View tab           Data group            Tables           Cost. 

In the "Resource Usage" view, the "Cost table" can be seen.
On the "Resource Usage" Tools            Format tab           Details group           
 Cost detail to add to the time-phased side of the view.
To add more time-phased details           Add Details        Detail Styles dialog
box open. Then, in the Available Fields list         cost-related fields add                 

Display the Cost table and cost details in the Resource Usage view

1.

2.

3.

4.

                    Show.

Display the Resource Cost Overview report

On the Report tab          "View Reports" group           Costs           "Resource Cost"
Overview.

On the View tab              click "Resource Views" group               "Resource Sheet"                 

Display the Cost table in the Resource Sheet view

1.
        to display the Resource Sheet view.
    2. On the View tab                Data group                 click Tables               select Cost.

33

Sort resources by cost amounts

1. Present the Cost table.
2. Click the AutoFilter         dropdown arrow next to a column heading: Cost or  
     Variance                  Sort Largest to Smallest from the menu that  
     appears.

Learn the ins and outs of
Project.

Getting Started



Practice 3

Create a report for each of the progress and costing
involved from the project plan in Practice 2 

34
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You can learn about some of MS Project s more complex formatting
choices in this chapter. An effective format can be very helpful for
delivering information to resources, clients, and other stakeholders.
Some formatting options in Project are comparable to those in style-
based word processors like Microsoft Word, where applying a style
once has an impact on all content in the document. In Project, styles
can be used to alter a certain type of Gantt bar s appearance
throughout a plan, such as a summary bar. Additional formatting
options are provided in this chapter, including task-specific
formatting and formatting of some of the most popular views.

Format and Print Overview
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This chapter explains how to format and print views using Project s more
sophisticated formatting and printing tools.
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Click File tab       click Organize Global Template         windows popup appear

Organize Global Template
When you open Microsoft Project, an empty project file contains all of the typical
Views, Tables, and Calendars, but no Tasks or Resources. The Global Template for
Microsoft Project, which is a file with the name Global, contains all of this
information.

Organizer popup show the calendars available in  project planning

37



On Gantt Chart Tools            Click on Gantt Chart Styles group and select the styles or
click on small arrow on the bottom of the left side            Bar Styles Dialog box were
open
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Format a "Gantt chart" View

Different types of items can be formatted to alter how they appear in a Gantt chart
view. You can accomplish this by using the "Bar Styles" dialogue box. A Gantt chart
view s formatting and bar style changes only impact that view.

To change the appearance of entire categories of items in the Gantt
chart views as demonstrated above, use the Bar Styles dialogue box.

The formatting modifications you make to a certain bar type (critical tasks, for
instance) or other elements in this dialogue box are applied to all of that bars or
other items in the Gantt chart.



Format a Timeline view

The "timeline view" is a convenient method to understand the plan s "big picture."
In a single Timeline view, you can display one or more timeline bars, each of which
can be customized separately.

On View tab                 Split View Group                 tick on the check box of Timeline

Click on Display on Timeline to appear the Planning Task

Task will be displayed on Timeline.

Right-Click on Timeline to change the formatting
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Create a custom report

Any combination of data that you desire can be included in custom reports. To
communicate information that isn t available anyplace else in Project, you can really
integrate tasks, resources, and other data into a single report.

Custom report to be consider for any of the following elements:

Charts Create a report with bar, area, or other sorts of charts.

Tables are used to present data in a row-and-column format.

Add images to a report, such as JPEG or PNG format files.

Insert and customize pre-made shapes like speech bubbles, circles,
and arrows. Shapes are a great way to draw attention to important
information in a report.

Boxes for text Insert a Text Box anywhere on a report..

The "Insert group" in the "Report Tools Design" tab contains the buttons for adding
various components to a report.

To add elements to a report, use the buttons in the insert group of the
Report Tools Design tab.

Use these features in a Project report the same way you would in a PowerPoint
presentation or an Excel spreadsheet in Microsoft Office.

Charts and tables are distinct from the rest of the report s components. Charts
and tables use data from the project s open-task plan s and resource fields. As the
underlying data in the plan changes, the field values on a chart or table will be
immediately updated.



On the "Report Tools Design" tab            Insert group,          Chart to open
the "Insert Chart" dialog box.
On the left side of the dialog box             choose chart types you want    

The project displays the Field List pane and adds the new chart
to the report.

Add Chart to a Report

1.

2.
       select the specific chart layout you want. 
   3.  Click OK. 

    4.   Drag the chart to position anywhere you want it on the report.

Create  A Bar chart for Progress report

The Chart Tools Design and Format tabs show up when you add or select a chart.

The Design tab is where you can get creative. Using the buttons on this
page, you can alter the chart s format and appearance as well as add
features like data labels.
The Format tab is located on the toolbar. Format chart elements such as
data series using the buttons on this tab.

Drag the chart to the desired location on the report.
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On the "Report Tools - Design" tab            Insert group         
 click Table.
Drag the table to any place on the report

Add Table to a report

1.

2.

You can also add a table report and customize the table.

Click on the chart.
On the "Chart Tools - Format" tab            choose  the chart elements, and other
options you want.
On the "Chart Tools - Design" tab           choose the layout, color, or style options
you want.

Change a chart’s format and style

1.
2.

3.
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Choose File          Print         

A view, report, or calendar can be printed in Project in a manner that is quite similar
to that of other Office applications:

Print a View or Report
A printed view of a project is more than just a pretty way to display project

information. It may occasionally be the best course of action. You can share views of

Project that exactly present the data you want to convey.

Make a report ready for printing

Format the report

To ensure that the report only contains the information you want to print, create it
and make any required edits.

You can change the colours and add visuals, as well as add charts, tables, and
links.
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 On the report, choose the "Report Tools - Design" tab               "Page Setup" group   

Click  File  tab           Print           select options under Settings.

1.

                       Select following options : "Page Breaks", "Margins", "Orientation", or "Size".

    2. The report will display recommendations that adapt to your decisions.

    3. To set other print options, 

Click the File tab            Print            Page setup 

Click on the Header or Footer tab.

Use the Left, Center, or Right text boxes to enter your text.

To format the text or add items, use the buttons beneath the text box:

Add a header or footer

1.

2.

3.

4.

View the Print Design

or
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Prepare a report for printing

Format the report

See the print layout as you work on the report

Put a header or footer

 To display just top-level tasks, hide subtasks.

 To emphasize certain information, sort tasks or dates.

 Temporarily hide columns on the printout

Choose your preferred viewpoint.

To display only the information you want to share, change the view.

 As an illustration:

a.

b.

c.

Practice 4

Bar Styles
Timeline view

Show each phase involved
Format the timeline
Show each subtask in the timeline

Custom report as chart, tables or images included.

From the Project plan from Practice 3, format each as
follow:

1.
2.

a.
b.
c.

3.
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Keyboard Shorcuts
General Shortcuts

Open an Existing project ( Ctrl + O )

Create a new project  ( Ctrl + N )

Save a project ( Ctrl + S )

Print a project ( Ctrl + P )
Close a file      ( Ctrl + W )
Close project   ( Alt + F4 )

Help ( F1 )

Spell check ( F7 )

Zoom in ( Ctrl + / )

Zoom out  ( Ctrl + Shift + * )

Up one Screen   ( Page Up )

Down one Screen  ( Page Down )

Show filtered tasks or resources  ( F3 )

Display Field Settings  ( Alt + F3 )

Show task or resource information    
 ( Ctrl + F2 )

Hide subtasks  ( Alt + Shift + - )

Show all tasks ( Alt + Shift + * )

Navigation and Views

Cut  ( Ctrl + X )

Copy  ( Ctrl + C )
Paste  ( Ctrl + V )

Undo  ( Ctrl + Z )

Redo   ( Ctrl + Y )

Create a hyperlink  ( Ctrl + K )

Add a new task  ( Insert )

Editing

Find   ( Ctrl + F )

Cancel and entry  ( Esc )

Clear/reset field  ( Ctrl + Delete )

Fill down  ( Ctrl + D )

Link tasks ( Ctrl  + F2 )

Unlink tasks ( Ctrl + Shift + F2 )

Set task to manually schedule               
( Ctrl + Shift + M )

Set task to manually schedule         
 ( Ctrl + Shift + A )

Bold    ( Ctlrl + B )

Formatting

Italics  ( Ctlrl + I )

Underline  ( Ctlrl + U )
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